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General safety issues 

The DDiag tool kit had been particularly developed for experts to conduct measurement, tests and 
recordings of hydraulic pressure and pressure patterns in the field. Please be aware that providing 
inspection services on pressurised systems goes along with a certain potential of safety risks. This 
manual does not generally or specifically describe the possible risks of conducting pressure tests, but 
concentrates to explain the available DDiag features. With regard to the general risks we assume, 
that experts conducting pressure tests have got the necessary training and experience, and they 
know and observe all applicable codes and standards. 

We would like to explicitly refer to the safety precautions in chapter 3 of this manual. Every DDiag 
user has to fully understand the technical scope and the consequences of the application, and has to 
observe the existing work procedures. To prevent any risk that may be caused by the application of 
the DDiag, it is essential to read and understand the following chapters before starting to make 
pressure test using the DDiag. As a principle, the application of the DDiag tool kit is limited to the 
indented purposes.  

 
 
 
 
Disposal of electrical devices 

 
The TÜV SÜD Industry Services is a German producer registered in compliance with the Directive 
2002/96/EC of the European Parliament on waste electrical and electronic equipment (WEEE). 
Electronic devices of, such as the DDiag dual pressure gauge, are considered “Monitoring and control 
instruments”, purely B2B products, as per category 9. The manufacturing process had been made in 

compliance with the European Directive 2002/95/EC (RoHS: Restriction of the use of certain 
hazardous substances in electrical and electronic equipment).  
 
TÜV SÜD will take back gauges and dispose them in compliance with the technical state of the art.  
 

 
 

 
 

Caution:  Please do only start measurements using the DDiag after you have read this 

user manual and you are familiar with the following safety precautions! 

 Do not dispose old or defective electronic DDiag gauges in 
domestic garbage. 

 
 Please do strictly observe any electronic waste disposal laws and 

requirements of your country. 
 
 Any user of DDiag is entitled to return the DDiag gauges to the 

TÜV SÜD, who will dispose of all parts at its own expenses. 
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This manual describes all the essential software functions of the DDiag program. 
 
The user must not expect that the manual is exhaustive. The software is subject to an ongoing further 
development and adaptation to new customer needs. Consequently, newly developed modules may show 
differences in the effective software function and the explanation in this manual. 
 
All users will obtain the latest update version of the software whenever the transducer is returned to TÜV 
Industry Service, Muinich for re-calibration. 

 
© 2004-2012 TÜV Industry Services              All rights reserved. 
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1 DDiag • General issues 
 

The TÜV Industry Service is an international inspection and certification body, involved in various 
fields of safety inspections. To enhance the competence of its own expert engineers conducting 
inspections and measurements on industrial plants and installations, TÜV SÜD developed own PC-
driven measuring methods, among others the dual range DDiag pressure gauge that comes together 
with the DDiag software. DDiag is a universal tool not only for making measurements on pressure 
equipment such as boilers, pressure vessels, process industry, pipe lines, pumps, hydraulic systems, 
construction machines, etc. TÜV SÜD also makes available these tools to externals customers, both 
under DDiag name or under OEM name. 
 
In general, any DDiag pressure gauge has 2 different measuring ranges, and it can be used both as a 
digital manometer as well as for the recording of pressure time relations. For making the recordings, 
you can select a most suitable sampling rate, as the program alternatively makes available 0.1, 1, 10, 
100 or 1,000 Hz. For the evaluation and assessment of the measurements, DDiag provides universal 
and powerful tools. Thus, it is a contemporary method for recording and documentation of pressure 
measurements.  
 
 

2 System requirements 
 

The present 32 bit version of DDiag is compatible with any actual operation system of WINDOWS. 
Further minimum system requirements include: 

 64 MB RAM 

 graphic mode 800x600, 16-bit or better 

 the program requires about 2MB capacity on the hard disk and sufficient capacity for saving 
measuring results  

 FTDI virtual COM port drivers for USB dual range transducer (is part of the delivery) 
 
 

3 Safety instructions  
 
Please observe all usual safety precautions when working at pressurized equipment. Wherever 
possible, use the quick coupling fitting to connect the transducer to the equipment. The included quick 

coupling is suitable for a direct connection under a pressure of 400 x 105 Pa [bar] respectively up to 

630 x 105 Pa [bar] for hydraulic oil as well as other kinds of mineral oil. 

 

Attention: Before you use the pressure transducer for the very first time, please read this 
manual carefully. For any damage that is caused by non-observance of the 
instructions of this manual, by inappropriate or wrongful use, the warranty is 
ceased, and no liability or compensation is taken for consequential loss.  

      Strictly observe all applicable safety regulations for the use of pressure gauges! 

During the calibration of the transducer hydraulic oil has been used as a pressure fluid medium. In the 
cavity of the transducer you may find residual oil. As the gauge does not have a flush mounted 

diaphragm, the use in the food industry is of limited suitability. 

Attention: Before making measurements of pressurized oxygen (or any food stuff) you have 
to carefully degrease the transducer first, using a suitable solvent. 
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4 Technical data 

 
Presently, there are 2 different DDiag dual pressure gauges available for an application of pressure of 
up to 250 as well as 630 x 105 Pa [bar]. Every gauge can be alternatively used in a lower or in an 
upper measuring range.  
 
The 630 bar gauge can be used for pressures of up to 1,000 x 105 Pa [bar], provided a suitable and 
approved fitting is in use. However, the calibration of this device is for 630 x 105 Pa [bar] only. 
 

Measuring range: 

(lower range) 0 - 100 x 105 Pa [bar] 0 - 400 x 105 Pa [bar] 

(upper range) 0 - 250 x 105 Pa [bar]  0 - 630 x 105 Pa [bar] 

(other ranges on request)     

Over range limit 500 x 105 Pa [bar] 1500 x 105 Pa [bar] 

Burst pressure 1200 x 105 Pa [bar] 3000 x 105 Pa [bar] 

Measuring rate (alternatively) 1000 Hz, 100 Hz, 10 Hz, 1 Hz, 0,1 Hz 

Precision class  0,50% 

Linearity deviation for max. pressure  < 0,2 % 

Hysteresis  < 0,1 % of full range 

Stability per year  < 0,2 % of full range 

Measuring principle thin film device 

Pressurized medium contact  CrNi steel (1.4571 / 1.4542) 

Permissible temperature range 
for pressure medium *) - 40 up to +100 °C 

Compensated temperature range 
of the transducer - 40 up to +100 °C 

Working- / ambient temperature  0 up to 70 °C 

Fitting  G1/4"  according to  DIN 3852 

Calibration  works calibration certificates are stored in electronic data plate; 

 

 system integrated control of measuring devices 

Power supply of sensor  from PC via USB port (complying with USB specification) 

Mass 150 g 

Maintenance       no specific maintenance required 

 

*) a higher process temperature is possible if a temperature isolator is used 
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5 Software installation  

DDiag requires any actual version of Windows. 

The DDiag software including the user manual is made available for downloading from a specified 
TUV SUD web site. The provided information (https-link, user ID and password) gives access to the 
web server. There you find a choice between a complete installation and an update, of both a German 
(iDDiagD.*) or an English (iDDiagE.*) version. In case of an initial installation of the DDiag software to 
the PC use the complete installation.  

Please download the zipped program file to your PC, or directly open the file from the TÜV SÜD 
SharePoint server.  

Install the English version by double clicking to the iDDiagE.exe 
file. Then click onto Install to proceed. The installation process is 
rather fast; it copies the software onto the hard disk and 
generates an icon on the desktop, to easily start DDiag.  

Alternatively, the DDiag is available in other language versions, 
provided a file DDiagXXX.DLL exists. Example: DDiagDEU.DLL 
stands for the German Version.  

To call up the German version extend the command line to:  
DDIAG \resource DDIAGDEU.DLL 

 

In case, there is no appropriate device driver installed, start the 
file CDM20814_Setup.exe in the subdirectory \DDiag\driver.  

If still in the pressure gauge will not be detected in the senor test 
(see chapter 6.5.1), please install manually another driver which 
is provided in subdirectory \DDiag\driver. 

 

 

 

Follow the instructions of the „Found New Hardware Wizard“. 

  

As soon as the wizard has finished installing the software, click 
Finish to close the wizard. 

 
 
 
 

 

After finishing the installation of the device drivers DDiag is ready for use. Start the program by double 
clicking the DDiag icon on the desktop, or on the file DDIAG.EXE in the directory C:\DDiag. 

The DDiag-User-Manual and other useful information are made available in the folder DDiag\Infos. 
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6 The software programs 

DDiag is a typical Windows program.  

6.1 Menu item File 

The menu starts with File and has got typical sub 
menus such as “Open”, “Save” or “Export data” that 
you know from other programs as well.  

DDiag is using so called wizards, giving you a simple 
online explanation of the next steps coming up. Every 
single wizard can be switched off by ticking the field 
Do not show this page again. 

It is recommended that users before they gain 
experience keep the wizard switched on. 
 
 
 
 

6.2 Menu item Edit 

In the Edit menu you will find 3 programs: 

Copy copies the selected diagram to the clipboard. 

Use the Comments... menu to add any supplement 
information to be saved together with the curve. 

Select Parameters to enter of modify specific data of 
the test, such as equipment number, rated pressure, 
etc. 

The menus Copy and Parameter are only available if 
a diagram is displayed. 
 
 

6.3 Menu item View 

The View menu provides several features to modify 
the information displayed on the screen.  

On the Tool bar (top) all icons for tools are 
displayed, which are currently available. Most icons 
are only visible, if a diagram is also displayed at the 
same time. The functions “Zoom in”, “Zoom out”, 
“View all”, “Filter”, “Information...” and “Diagram 
properties” are also accessible via the pull down 
menu “View”.  

 

 

The Status bar (bottom line) provides brief information, especially if a diagram is displayed.  

If the Status window is activated, it displays essential data of the current diagram.  

Under certain conditions not all menu items can be activated. 

Grid lines can only be switched on or off, if at the same time the auto-scale function is deactivated. 
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6.4 Pressure (Execution of measurements) 

 
Select the Pressure menu if you want to conduct any 
kind of measurement with the DDiag dual range 
pressure gauge on pressurized mediums. 

You can alternatively display the current pressure 
[Display…] like a digital manometer 
or 
record a pressure versus time measurement  [P=f(t)] 
 
If no pressure gauge had been connected to the PC 
before, a Sensor  Test... is required (see 6.5.1) 
 
The Safety valve function requires specific hardware. 
 

 

6.4.1 Pressure  Display… 
 
This program enables you to measure the pressure of the 
gauge and display it on the screen like a digital 
manometer. It is especially suitable for displaying a static 
or quasi-static process. 

It is recommended to connect always the transducer to the 
pressurized equipment via the quick coupling. 

 
 
 
 

 
 
 
Like during the sensor test, the program starts a scanning 
process, to identify the pressure gauge connected. 
 
Click onto Rescan if no sensor has been detected. 
 
 
 
 
 

 
 
The result of the measurement is displayed like a digital 
manometer. 
 
 
 
 
In case you want to record a pressure time diagram, select 
the menu Pressure  P=f(t). 
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6.3 Pressure Diagram 
 
With this program you can make recordings of dynamic pressure 
versus time relations as well as complex evaluations of the 
findings. 

It is recommended to connect always the pressure gauge to the 
pressurized equipment via the quick coupling.  

 
 
 
 
Use this entry mask to include all relevant equipment information 
that later will become a part of the documentation. 

Specify here also the file name to save this measurement. 
 
 
 
 

Now select the required sampling rate.  

If you are uncertain what is the most suitable rate choose a 
higher rate, as you can always compress the diagram if 
necessary.  

The length of the recording is just limited by the capacity of the 
hard disk.  

Press Continue to proceed to the next screen. 

 
Before recording is started, the selected measuring range, the 
serial number of the transducer and the actual pressure are 
displayed.  
 
Click onto Recording to start. 

 
 
 
After starting measurement the “Pressure Recording 
Wizard” displays the actual pressure, the number of 
measurements already and the time lapsed.  

Behind the wizard the pressure-versus-time curve is 
displayed in red colour.  

 

 

To finish recording click onto Finish. 
 

 
6.4.3 Safety valve 

 
For this kind of measurement a specific gauge is required. The relevant chapter of the user 
manual will be supplied together with the gauge.  
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6.5 Sensor 

 

Under this program item the acuracy / offset behavior 
of the transducer can be verified by Test… 

Furthermore, the Calibration certificate saved in the 
memory of the gauge can be displayed or printed. 

For advanced remote control an Export/Import 
Header… feature is available. 

 

 

 

 

6.5.1 Sensor  Test… 

In case you are using the DDiag software for the very first time, and if no 
sensor test had been called up before, you will be asked to start the Sensor 
test. However, you can also start this test later again. 

 

The Wizard will guide you through the program. Just follow the 
instructions.  

Now connect the transducer with the PC via the USB 
transmission cable.  

Please observe that the transducer is not pressurized when 
making this test. 

 

 

 

 

 

Transducers connected to the PC will be automatically identified 
and the particular (virtual) serial port is selected for being used 
with DDiag.  

 

 
After clicking on Continue a detailed verification of the 
transducer’s function is initiated.  

First, the sensor’s electronic data plate of is read and displayed. 
Then the verification of calibration is started. This takes some 10 
seconds for each range, beginning with the upper one. 

This device test displays month and year of the last calibration, 
the recommended validity of calibration as well as the expiry 
time. 
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Finally, the transducer’s zero offset will be set and saved for 
future measurements using this transducer. 
 
Press the Set to zero button and repeat that test for the second 
measuring range accordingly. 
 
 
 
 
 

 
6.5.2  Calibration certificate 

 

The findings of the last factory calibration are saved 
in a non-volatile memory of the transducer. Diagrams 
can be displayed or printed.  

Once you confirm the connected sensor by „Next“, a 
diagram appears with the deviations for the upper 
measuring range. With the Enter-key you can 
proceed to the lower pressure range. 

 

 

 

 

The program item File  Print preview displays the 
available information as Certificate of Manufacturer’s 
Calibration, which can printed out here. 

 

 

 

For calibration see chapter 8. 

 

 

 

 

6.5.3  Export/Import Header 

This function is reserved for specific applications and is not commonly available for users.  
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6.6 Tools 

Further auxiliary programs are made available under the Tools menu. 
 
6.6.1 Stop-watch 

 
 
 
 
With the Stop-watch feature the PC works like an 
ordinary stop-watch, having a resolution of 0.01 s 
and is to be controlled with the keyboard. 
 

 

 

 

 

 

 
6.6.2 Compound view 

 

The menu Compound view enables you to select several 
diagrams (that already had been saved to the hard disk) and 
display these curves one above the other on one screen in 
order to compare them against one another. 

This function is mainly addressing experienced users. 

 

 

 

 

First, select the files that you wish to display at the screen at the 
same time.  

 

 

On the next screen you can specify for each diagram an 
individual offset value. (We only recommended this feature for 
particular cases.) If necessary you can also adjust the individual 
offset value with the program Compound view offset…. 
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All selected diagrams are displayed together on the 
screen. To activate one of the diagrams just click on 
it. The head line then appears in bold letters and all 
features (cursor, filter, results in the status window, 
etc.) only refer to this activated diagram. 
 

The icons  shift the zero offset values. If you 
keep in addition the [Shift] button pressed, you are in 
the slow mode, and respectively if you keep the 
[Strg] button pressed you are in a fast shifting mode. 
 
 
 

 
 

6.6.3 Options 
 
You can specify here required parameters for making measurements or displaying findings. 

 

Use the menu Options - General to select various parameters, 
such as the use of metric or imperial pressure units (bar, kPa, 
mmWS or PSI), or the units of the diagram’s time scale (number 
of measuring points, seconds of minutes). 

Print date and time in diagram specifies, if these data become 
a part of the print out. 

Tick Print introduction page if you want to use that as a part of 
your documentation. 

Tick Print in colour only in case you are using a colour printer. 

 

 

Select the measuring range of the dual gauge that you want to 
use for the next measurement in the Options - Devices menu. 

It is recommended that you make use of the full range of the 
gauge, if possible. You cannot overstress the gauge in the lower 
range, if the actual pressure will not exceed the upper range. 
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7 Evaluating test results 
 
Immediately after you finish recording the 
findings will be displayed in a diagram 
and you can start analyzing the measure-
ment by setting boundary lines. 
 
Extensive assessment functions and a 
wide variety of graphic representations 
are a part of the program.  
 
 
 
 
 
 
 
 
 
 
 

 
In particular, you will find several icons on the symbol bar to modify the diagram: 
 
Use  to compress or expand the curve displayed.  
 
Usually, the so-called auto-scale modus is activated. In this mode, both the minimum and maximum 
values are scaled to the optimal size displayed on the screen. If you want to compare different 
diagrams with each other, you may display the gauges full measuring range. In such as case click on 
to deactivate the auto-scale function. 

Very often you will have to analyze just a part of the diagram. Press the icons to set and 
activate cursor lines, which form the boundaries of the part of diagram. 
 
When activating a cursor the icon becomes shaded and a dotted vertical line appears in the diagram. 
You can shift this line, alternatively using the mouse and keeping the left button fixed or with the 
cursor keys. Shifting the boundaries by only the cursor keys is considered the default mode, if in 
addition you keep the [Shift] button pressed you are in the slow mode respectively if you keep also the 
[Strg] button pressed you are in a fast shifting mode. 
 
The status window does not only summarize the results but states also the measuring parameters 
Sampling rate and Measuring range. The result Pressure is the average value between both 
boundaries. Lower limit is the time lapsed since the beginning of the recording until Cursor1, Upper 
limit correspondingly until the position of Cursor2. Time means the time period between both cursors. 
 
The icons automatically position the boundary lines to the minimum / maximum value of 
the measurement, and at the same time position the curve most conveniently. In order to shift the 
whole diagram you can use the arrow keys or [Page up /down] (in case no boundary is activated) or 
by moving the mouse on the "Verschiebebalken" at the lower edge of the screen. 
 
When the   icon is clicked, all measuring results will be displayed on exactly one screen only.
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The  icon starts the digital filter functions. You 
can select among 4 pre-defined and 2 more custom-
made filters for very special applications. These 
options are specifically made available for 
experienced users having particular know-how in that 
field. The filter function does neither influence the 
course of the curve nor the recorded data; that 
means the initial values are not changed and can be 
displayed later with other filter functions or without 
any filter again. 
 
 
 

With  you open an information window which 
summarizes important data of the measurement as 
well as the pressure gauge used. Among other things 
you find here the time stamp of the recording and the 
expiry date of calibration, fact that are quite essential 
for documentation purposes. 
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8 Software-integrated automatic control of testing devices  
 
The serial number, the calibration date, the calibration diagrams for both channels and other data are 
saved in the electronically data plate of the transducer. 

 
 
The software has got the appropriate 
features to display both calibration 
diagrams (saved in the memory) under 
Tools – Calibration certificate.  
 
Select File – Print Preview for making a 
printout of the diagrams. 
 
 
 
 
 
 
 
 
 

 
Before any measurement is made the software verifies that the calibration of the transducer has not 
yet been expired. In case a new calibration is required the user will get a message in this regard. 
Thus, any further control of the calibration of the pressure gauge is not required. 
 
The transducer should be re-calibrated once every 3 years at the latest. Without a re-calibration the 
use of the DDiag pressure gauge will expire after 4 years. 
 
On request of the user shorter expiry of calibration periods can be implemented in the sensor. 
 
All transducers delivered had been calibrated on the basis of guideline DAkkS DKD-R-6-1. 
 
Periodic manufacturer’s calibration service of the transducers is made by TÜV Industry Service at a 
nominal fee. 
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8 Scope of delivery 
 
The scope of delivery consists of  

 
 
1 pc.  Dual range pressure gauge DDiag 
          with sensor direct coupling 
 
 
 

 

 

 

 

 

 

 

 

 

 

1 pc.  USB transmission cable (EMC) 5m  
 

 

 

 

 

 

 

 

1 St. Sensor-hose-coupling  

 

 

 

 

DDiag software, incl. User manual 

 

and, additional accessory parts when requested by customer (see chapter 10) 
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10 Accessory parts  

 

 

Direct transducer coupling 

 

 

 

 

 

Transducer hose coupling 

 

 

 

 

Adapter for testing gauge 

(M20x1.5mm internal thread) 

(Packing unit 25 pc) 

 
 

 
 
EN adapter (external ½“ thread) 

(Packing unit 25 pc) 

 

 

 
 
 

 

 
 
USB transmission cable for DPT  

5 m, with EMC protection  

 

 
 
 

 
 

 

Active USB transmission cable  

Extends the connection of the DPT to the PC 

for another 5 m (maximum transmission  

length is 15 m) 
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10 DDiag in brief 

 

DDiag = 1 electronic dual pressure gauge + software + accessory parts 

 
What is DDiag?  

The contemporary PC-driven tool for the recording, analysis and documentation of any kind 
of pressure measurement on any kind of pressure equipment in industry and plant 
engineering 

Ready for use hardware & software tool kit, including all required accessory parts 

DDiag software for Windows, including an online help and manual 

Communication from PC to pressure gauge via standard USB cable 

Main features:  

Transducer with 2 separate measuring ranges:     0 – 100  and   0 – 250 * 105 Pa (bar) 

or:            0 – 400  and   0 – 630 * 105 Pa (bar) 

(other measuring ranges on request) 

Precision class      0.5%, 12 bit (internal resolution) 

Measuring rates (alternatively): 1000 Hz, 100 Hz, 10 Hz, 1 Hz, 0.1 Hz for both short-time 
recordings of fast dynamic processes as well as long-term pressure monitoring 

Excellent software tools for the evaluation and documentation of all test results, including 
extensive digital filter functions, compound view and multiple scaling features 

Software-integrated automatic control of device calibration: The calibration certificates are 
stored in the device memory. A further usage of the transducer is rejected, if the calibration 
period has been expired. Thus, no further control of calibration of device is required.  

Periodic recalibration of devices by TÜV SÜD Industry Services (for a nominal fee) 

 
 
 
 
 
Manufacturer / supplier: 

 
TÜV SÜD Industry Services  
Innovative Systems 
Westendstr. 199 
D-80686 Munich / Germany 
 
Fax:  +49 - 89-5791 2989 

E-Mail: ddiag@tuev-sued.de 
 

mailto:ddiag@tuev-sued.de

